# Table of Contents

<table>
<thead>
<tr>
<th>PART 1</th>
<th>TYPING SKILLS</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Home and Special Keys</td>
<td>2</td>
</tr>
<tr>
<td>1.2</td>
<td>QWERTY Row of Keys</td>
<td>3</td>
</tr>
<tr>
<td>1.3</td>
<td>ZXC Row of Keys</td>
<td>4</td>
</tr>
<tr>
<td>1.4</td>
<td>The Numeric Keys</td>
<td>5</td>
</tr>
<tr>
<td>1.5</td>
<td>Special Characters</td>
<td>6</td>
</tr>
<tr>
<td>1.6</td>
<td>Cursor Controller Keys</td>
<td>7</td>
</tr>
<tr>
<td>1.7</td>
<td>Function Keys</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PART 2</th>
<th>MICROSOFT OFFICE WORD</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>The Microsoft Word Screen</td>
<td>10</td>
</tr>
<tr>
<td>2.2</td>
<td>Menu Bar</td>
<td>14</td>
</tr>
<tr>
<td>2.3</td>
<td>Standard Toolbar</td>
<td>16</td>
</tr>
<tr>
<td>2.4</td>
<td>Formatting Toolbar</td>
<td>18</td>
</tr>
<tr>
<td>2.5</td>
<td>Document Layout</td>
<td>20</td>
</tr>
<tr>
<td>2.6</td>
<td>Drawing Toolbar</td>
<td>22</td>
</tr>
<tr>
<td>2.7</td>
<td>Shortcut Keys</td>
<td>24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PART 3</th>
<th>COMPUTERS AND ME</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Computer and the Society</td>
<td>26</td>
</tr>
<tr>
<td>3.2</td>
<td>Computer Care and Safety</td>
<td>27</td>
</tr>
<tr>
<td>3.3</td>
<td>Your First Email</td>
<td>29</td>
</tr>
</tbody>
</table>

GLOSSARY
REFERENCES

Page Number
Every computer student must know the proper way of typing. One can finish his work easier and faster if he masters the computer keyboard (also in typewriter). Each finger is assigned with a key or several keys in the keyboard. In this part of the book, one will learn the right way of typing.

**LEFT**

Index

Middle

Pinky

**RIGHT**

Index

Middle

Pinky

Thumb
Lesson 1 - HOME and SPECIAL Keys

Home keys are keys across the middle of the keyboard. It is called home because this is where the fingers are comfortably rest on.

The left hand is used for the following keys:

- Pinkie → A
- Ring → S
- Middle → D
- Index → F, G

The right hand is used for the following keys:

- Index → J, H
- Middle → K
- Ring → L
- Pinkie → ;

Special Keys are those keys with special uses:

1. Enter / Return - moves the cursor to the next line.
2. Shift – changes the characters into its uppercase when pressed one at a time; pinkie is used to press. The left shift is used when the character to be pressed with is on the right; for example K. The right shift is used when the character to be pressed with is on the left; for example D.
3. Caps Lock – when pressed, changes the letter keys into their upper case without using shift.
4. Spacebar – inserts a blank space when pressed; either thumb can be used.
5. Backspace – removes characters or spaces while cursor moves to the left.
6. Delete – removes characters or spaces on the right of the cursor.
LESSON 2 – QWERTY Row of Keys

A common keyboard is sometimes called as QWERTY because they are the first row of letters across the keyboard. Look at the drawing to discover which letters belong to this group:

The left hand is used for the following keys:

- Pinkie → Q
- Ring → W
- Middle → E
- Index → R, T

The right hand is used for the following keys:

- Index → Y, U
- Middle → I
- Ring → O
- Pinkie → P
LESSON 3 - ZXC Row of Keys

The ZXC Row of Keys is the set of letters nearest the spacebar. Did you notice that all of them are consonants?

The left hand is used for the following keys:

- Pinkie → Z
- Ring → X
- Middle → C
- Index → V, B

The right hand is used for the following keys:

- Index → N, M
LESSON 4 – THE NUMERIC KEYS

The present keyboards have two sets of number keys. The first one is found at the top of the QWERTY row wherein they have corresponding special characters (to be discussed later) on the uppercase.

The left hand is used for the following keys:

- Pinkie → 1
- Ring → 2
- Middle → 3
- Index → 4, 5

The right hand is used for the following keys:

- Index → 6, 7
- Middle → 8
- Ring → 9
- Pinkie → 0

The other is found on the right of the keyboard called as the numeric keypad; any finger on the right can be used.

Picture Source: http://www.rackmountmart.com/prodspics/lcd1u17-07-new-ky.JPG
LESSON 5 – SPECIAL CHARACTERS

Special Characters are symbols used in our documents like punctuation marks, math symbols, etc. Several of which are shown by pressing special keys.

<table>
<thead>
<tr>
<th>Name</th>
<th>Symbol</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclamation Point</td>
<td>!</td>
<td>Shift + 1</td>
</tr>
<tr>
<td>At Sign</td>
<td>@</td>
<td>Shift + 2</td>
</tr>
<tr>
<td>Pound / Sharp</td>
<td>#</td>
<td>Shift + 3</td>
</tr>
<tr>
<td>Dollar</td>
<td>$</td>
<td>Shift + 4</td>
</tr>
<tr>
<td>Percent</td>
<td>%</td>
<td>Shift + 5</td>
</tr>
<tr>
<td>Caret</td>
<td>^</td>
<td>Shift + 6</td>
</tr>
<tr>
<td>Ampersand</td>
<td>&amp;</td>
<td>Shift + 7</td>
</tr>
<tr>
<td>Asterisk</td>
<td>*</td>
<td>Shift + 8</td>
</tr>
<tr>
<td>Open Parenthesis</td>
<td>(</td>
<td>Shift + 9</td>
</tr>
<tr>
<td>Close Parenthesis</td>
<td>)</td>
<td>Shift + 0</td>
</tr>
<tr>
<td>Dash / Hyphen/ Minus</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Underscore</td>
<td>_</td>
<td>Shift + -</td>
</tr>
<tr>
<td>Equal</td>
<td>=</td>
<td>=</td>
</tr>
<tr>
<td>Plus</td>
<td>+</td>
<td>Shift + =</td>
</tr>
<tr>
<td>Backward Slash</td>
<td>\</td>
<td>\</td>
</tr>
<tr>
<td>Logical Or</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Brace</td>
<td>[</td>
<td>]</td>
</tr>
<tr>
<td>Closed Brace</td>
<td>]</td>
<td>[</td>
</tr>
<tr>
<td>Open Bracket</td>
<td>{</td>
<td>Shift + [</td>
</tr>
<tr>
<td>Closed Bracket</td>
<td>}</td>
<td>Shift + ]</td>
</tr>
<tr>
<td>Semicolon</td>
<td>;</td>
<td>;</td>
</tr>
<tr>
<td>Colon</td>
<td>:</td>
<td>Shift + ;</td>
</tr>
<tr>
<td>Single Quote</td>
<td>‘</td>
<td>‘</td>
</tr>
<tr>
<td>Double Quote</td>
<td>“</td>
<td>Shift + ‘</td>
</tr>
<tr>
<td>Comma</td>
<td>,</td>
<td>,</td>
</tr>
<tr>
<td>Less Than</td>
<td>&lt;</td>
<td>Shift + ,</td>
</tr>
<tr>
<td>Greater Than</td>
<td>&gt;</td>
<td>Shift + .</td>
</tr>
<tr>
<td>Period / Decimal Point</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>Forward Slash</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Question Mark</td>
<td>?</td>
<td>Shift + /</td>
</tr>
<tr>
<td>Grave Accent</td>
<td>‘</td>
<td>‘</td>
</tr>
<tr>
<td>Tilde</td>
<td>~</td>
<td>Shift + `</td>
</tr>
</tbody>
</table>
**LESSON 6 – CURSOR CONTROLLER KEYS**

Cursor Controller Keys are used to manipulate the cursor or insertion point.

<table>
<thead>
<tr>
<th>Name</th>
<th>Symbol</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow Up</td>
<td>↑</td>
<td>Moves cursor one line above</td>
</tr>
<tr>
<td>Arrow Down</td>
<td>↓</td>
<td>Moves cursor one line below</td>
</tr>
<tr>
<td>Arrow Left</td>
<td>←</td>
<td>Moves cursor one space backward</td>
</tr>
<tr>
<td>Arrow Right</td>
<td>→</td>
<td>Moves cursor one space forward</td>
</tr>
<tr>
<td>Home</td>
<td></td>
<td>Moves cursor on the start of the line</td>
</tr>
<tr>
<td>End</td>
<td></td>
<td>Moves cursor at the end of the line</td>
</tr>
<tr>
<td>Page Up</td>
<td></td>
<td>Moves cursor above</td>
</tr>
<tr>
<td>Page Down</td>
<td></td>
<td>Moves cursor below</td>
</tr>
</tbody>
</table>
**LESSON 7 – FUNCTION KEYS**

Unlike the type writer, a computer keyboard has a set of function keys located at the topmost part of the keyboard.

<table>
<thead>
<tr>
<th>Function Key</th>
<th>What Will Happen</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Get Help or visit Microsoft Office Online.</td>
</tr>
<tr>
<td>F2</td>
<td>Move text or graphics.</td>
</tr>
<tr>
<td>F3</td>
<td>Insert an AutoText entry (after Microsoft Word displays the entry).</td>
</tr>
<tr>
<td>F4</td>
<td>Repeat the last action.</td>
</tr>
<tr>
<td>F5</td>
<td>Choose the Go To command (Edit menu).</td>
</tr>
<tr>
<td>F6</td>
<td>Go to the next pane or frame.</td>
</tr>
<tr>
<td>F7</td>
<td>Choose the Spelling command (Tools menu).</td>
</tr>
<tr>
<td>F8</td>
<td>Extend a selection.</td>
</tr>
<tr>
<td>F9</td>
<td>Update selected fields</td>
</tr>
<tr>
<td>F10</td>
<td>Activate the menu bar</td>
</tr>
<tr>
<td>F11</td>
<td>Go to the next field</td>
</tr>
<tr>
<td>F12</td>
<td>Choose the Save As command (File menu).</td>
</tr>
</tbody>
</table>
Microsoft Word ® is a word processing program that allows creation of documents. To start MS Word:

1. Click START
2. Highlight Programs
3. Highlight Microsoft Office
4. Click Microsoft Office Word
LESSON 1 – THE MICROSOFT WORD SCREEN

The Title bar is located at the very top of the screen. It displays the name of the document on which you are currently working on. At the top of the screen, you will see “Document1 - Microsoft Word” or the name of your document.

The Menu bar is generally found directly below the Title bar. The Menu bar displays the all of the commands that can be used in MS Word. It is used to give instructions. Point with your mouse to a menu option and click the left mouse button to open a drop-down menu. You can now use the left and right arrow keys on your keyboard to move left and right across the Menu bar options. You can use the up and down arrow keys to move up and down the drop-down menu.
The **Standard Toolbar** shows the most commonly used commands to change or modify the whole document.

The **Formatting Toolbar** shows commands you will often use to change or modify text.

The **Ruler** is used to change the margins on your document.

The **Task Pane** appears on the right hand side of the screen when you start Microsoft Word. This pane allows you to access commands for specific task without having to use the menus or toolbars. To close this window, click on the small X button found on the right upper corner window.
**Status Bar**

*Status bar* appears at the lower part of the screen. It shows information such as the current page, total of pages, current line number, and current column number.

**Drawing Toolbar**

The *Drawing Toolbar* appears below text area. It contains drawing objects which you can insert into your document.

**Sizing Buttons**

These are used to control the size of your windows (Minimize, Restore, Maximize and Close Button)

**Scroll Bars**

Vertical and Horizontal bars allow you to move the document in the window up or down and left or right.
TYPING AND WORD PROCESSING

View Buttons
In Word, you can display your document in one of four views: Normal, Web Layout, Print Layout, or Outline.

![View Buttons](image)

Practice: Try running your mouse over each and every icon found on the screen to familiarize yourself with some of its name and functions.
Lesson 2 – Menu Bar

Menu Bar contains the most commonly used commands in MS WORD.

File – contains the general commands in manipulating the document.

New - opens a new document

Open - retrieves a saved document

Close - ends the document.

Save – stores the document automatically

Save As - stores an unnamed document

Page Setup - sets margins, paper size, orientation and other layout options.

Print Preview - shows how the file will look when you print it.

Print – transfers documents to papers

Exit - ends Microsoft Word.

Edit - contains commands for modifying documents

Cut - removes a selection from the document and places it on the clipboard.

Copy - duplicates the selection to the clipboard.

Paste – inserts the contents that was cut or copied at the insertion point (cursor).
View - shows different ways to display a Word document
- Normal
- Print Layout
- Web Layout
- Outline
- Full Screen

Insert – allows putting in additional elements on the document

Page Numbers – adds page number into the document

Picture – putting in pictures from clip art or a file. You can also insert auto shapes, word art, or a chart.

Format – contains commands that arranges the layout

Font - Change font style, size, color and a large number of other features. You can also change the spacing between letters here.

Paragraph – Change the indentations, alignment, line spaces and other features of a paragraph

Border - Create borders around blocks of text, or around the entire document.

Tools – contains helpful commands in correction and protection of the document

Spelling and Grammar – a helpful tool to correct spelling and grammar mistakes

Table – contains commands in making tables

Window - shows different MS Word documents that are open or running.

Help - answers questions about Microsoft Word features
LESSON 3 - STANDARD TOOLBAR

Standard Toolbar contains the most commonly used commands in MS Word.

- **New** - opens a new document
- **Open** - retrieves a saved document
- **Save** – stores the document automatically
- **Print** – transfers documents to papers
- **Print Preview** - shows how the file will look when you print it.
- **Spelling and Grammar** – a helpful tool to correct spelling and grammar mistakes
- **Cut** - removes a selection from the document and places it on the clipboard
- **Copy** - duplicates the selection to the clipboard
- **Paste** – inserts the contents that was cut or copied at the insertion point (cursor)
- **Format Painter** – copies the format from a selected object or text and applies it to the object or text you click.
**Undo** – removes the previous command executed

**Redo** – does again the previously command executed that was removed

**Insert Table** – puts in a table

**Columns** – arranges the document into columns

**Zoom** – sets the size of the document on the screen but will not change the print out.
LESSON 4 – FORMATTING TOOLBAR

The formatting toolbar contains commands that are used to edit texts and paragraphs.

- **Style** – is used to modify for document style
- **Font Face** – is used to change the font
- **Font Size** – enlarges or reduces the size of the font; the bigger the number the larger the font
- **Font Styles** – is used to emphasize text such as:
  - **Bold** – makes the text thicker
  - **Italics** – makes the text slanted
  - **Underline** – places a line under the text
- **Paragraph Alignment** – arranges the paragraph format like:
  - **Left** – aligns paragraph on the left side
  - **Center** – aligns the paragraph at the center usually done in songs or poems
  - **Right** – aligns the paragraph at the right usually done in closing salutations in letters
  - **Justify** – aligns the paragraph on both sides
Numbers – places number on a list like steps or procedures

Bullets – places symbols on a list items

Increase Indent – adds indention of the document

Decrease Indent – removes or reduces indention of the document

Highlighter – gives emphasis on the parts of the document by placing a background color on the text

Font Color – modifies text color
TYPING AND WORD PROCESSING

LESSON 5 – DOCUMENT LAYOUT

Document Layout is the arrangement of the document in a presentable manner.

On the File Menu, click Page Set Up. The Page Setup Dialog Box is displayed.

The first tab is the **margins tab** where the margins in all sides can be modified.

It also includes the Orientation wherein the page can be:

- **Portrait** – vertical page
- **Landscape** – horizontal page

Second is the **paper tab** where the paper size is set like letter for short bond paper and legal for long bond paper.

The third tab is the **layout tab**.

Another part of document layout is the line spacing. Right click on the work area and click paragraph. On the Indents and Spacing tab, under the Spacing group, choose the line spacing that you want:

- Single
- 1.5
- Double
- At least
- Exact
- Multiple

For borders, click the Format Menu and then click Borders and Shadings. It has 3 tabs namely
Borders – used for tables

Page Border – used for border of the page

Shading – used for changing border color
LESSON 6 – DRAWING TOOLBAR

The drawing toolbar contains tools used for drawings, pictures and lettering.

- **Select Objects** – upon drag and drop, selects multiple objects
- **AutoShapes** – places in shapes, lines and arrows
- **Line** – puts in a straight line
- **Arrows** – puts in one-headed arrows
- **Rectangle** – used for drawing rectangle and squares
- **Oval** – used for drawing oblongs and circles
- **Textbox** – inserts boxes for typing texts
- **Diagram** – places graphs, tables, charts and illustrations
- **Clip Art** – inserts graphics included in the MS Word installer
- **Pictures** – inserts photos from the devices like camera and scanner
Fill Color – changes the background color of objects

Line Color – changes the color of the selected line

Line Style – changes the thickness of the selected line

Dash Style – changes the line format into broken lines

Arrow Style - changes the design of arrows

Shadow Style – sets design of shadows in objects

3D Style – sets object design into a three dimensional form
Shortcut keys are combinations of key strokes that execute commands. There are over a hundred shortcut keys but here are the most helpful ones:

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + A</td>
<td>Select All</td>
</tr>
<tr>
<td>Ctrl + B</td>
<td>Bold</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Center</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Italics</td>
</tr>
<tr>
<td>Ctrl + J</td>
<td>Justify</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Left</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>New</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Right</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Underline</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Alt + F</td>
<td>File</td>
</tr>
<tr>
<td>Alt + E</td>
<td>Edit</td>
</tr>
<tr>
<td>Alt + V</td>
<td>View</td>
</tr>
<tr>
<td>Alt + I</td>
<td>Insert</td>
</tr>
<tr>
<td>Alt + O</td>
<td>Format</td>
</tr>
<tr>
<td>Alt + T</td>
<td>Tools</td>
</tr>
<tr>
<td>Alt + A</td>
<td>Table</td>
</tr>
<tr>
<td>Ctrl + Alt + Delete</td>
<td>Shut down</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Close</td>
</tr>
<tr>
<td>Alt + 164</td>
<td>ŕ</td>
</tr>
<tr>
<td>Alt + 165</td>
<td>Ń</td>
</tr>
<tr>
<td>Ctrl + =</td>
<td>Subscript (base)</td>
</tr>
<tr>
<td>Ctrl + Shit + =</td>
<td>Superscript (exponent)</td>
</tr>
<tr>
<td>Ctrl + Alt + C</td>
<td>Copyright (©)</td>
</tr>
<tr>
<td>Ctrl + Alt + T</td>
<td>Trademark (™)</td>
</tr>
</tbody>
</table>
PART 3: COMPUTERS AND ME

Computers are electronic devices that enable to process data and solve mathematical and logical problems a million times faster than a man can. However, they cannot work on their own. They need people for them to operate.

See how the computers affect the community. Learn the ways in taking care of your computer. Also, discover how to create and use emails.
# Lesson 1 – Computers and the Society (Computer Ethics)

## The Ten Commandments for Computer Ethics

<table>
<thead>
<tr>
<th>Commandment</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>You shall not use a computer to harm other people.</td>
</tr>
<tr>
<td>2.</td>
<td>You shall not interfere with other people's computer work.</td>
</tr>
<tr>
<td>3.</td>
<td>You shall not snoop around in other people's files.</td>
</tr>
<tr>
<td>4.</td>
<td>You shall not use a computer to steal.</td>
</tr>
<tr>
<td>5.</td>
<td>You shall not use a computer to bear false witness.</td>
</tr>
<tr>
<td>6.</td>
<td>You shall not use or copy software for which you have not paid.</td>
</tr>
<tr>
<td>7.</td>
<td>You shall not use other people's computer resources without authorization.</td>
</tr>
<tr>
<td>8.</td>
<td>You shall not appropriate other people's intellectual output.</td>
</tr>
<tr>
<td>9.</td>
<td>You shall think about the social consequences of the program you write.</td>
</tr>
<tr>
<td>10.</td>
<td>You shall use a computer in ways that show consideration and respect.</td>
</tr>
</tbody>
</table>

Source: Computer Ethics Institute  
(http://www.tekmom.com/tencommand/index.html)
LESSON 2 – COMPUTER CARE AND SAFETY

Like other things, computer also needs TLC (tender loving care) or else it would not function anymore. Here are some steps in cleaning the computers.

Computer Screen:
1. If your computer has a glass screen, spray glass cleaner onto a rag.
2. Wipe the screen to clean off all the dust and fingerprints.
3. Be sure to follow manufacturer's directions.

Note: DON'T spray cleaner directly onto the screen. It can shock you or maybe even break it.

Monitor Case:
1. For plastic cases, use a multi-purpose cleaner that is safe to use on plastic.
2. Spray it onto a rag and wipe over the case.
3. You can use a vacuum hose attachment to clean dust from the vents at the back.

Note: DON'T spray cleaner directly onto the case. It could run down in the vents and openings at the back.

Tower / Central System Unit:
1. For plastic or metal cases, clean the tower case like you do the monitor case.
2. Spray multi-purpose cleaner that is safe for plastics or metal onto a rag and wipe it clean.
3. The back of the tower can get very dusty. Spray away the dust with canned air or carefully vacuum with a soft brush attachment.
4. Now for the inside: your parents or teacher should clean that part. Remind them to unplug the computer first to be safe.
5. Use canned air to blow all the dust away.
6. Be careful not to bump anything loose in there.
7. The inside doesn't have to be cleaned very often, only about once a year.
TYPING AND WORD PROCESSING

Note: DON'T spray cleaner directly onto the case. It could run down in the vents and openings. Never use cleaner on the back.

Keyboard:

1. Clean the keyboard when the computer is off.
2. First it’s a good idea to use a can of air to blow out any dust and dirt that has settled down around the keys.
3. Use a vacuum with a hose and brush attachment to remove the dust.
4. Then use a multi-purpose cleaner like you do on the monitor case.
5. Lightly spray the cleaner onto a rag and wipe around and over the keys until they are clean.

Note: DON'T spray cleaner directly onto the keyboard. It can run between and under the keys, causing the keys to stick. Then they won't work.

Mouse:

1. Clean the mouse when the computer is off.
2. Use a multi-purpose cleaner that is safe for plastic.
3. Lightly spray it onto a rag and wipe over the mouse. Sometimes you need to clean the bottom of the mouse where the ball is.
4. If your mouse hasn’t been working smoothly, cleaning this area could help. Press easily on the round cover surrounding the ball and twist it. That pops it off and let's the ball come out.
5. Wipe it off with a lint free rag.
6. Look down into the hole where the ball sits. There are little rollers in there that can get tiny strands of gunk twisted around them sort of like a vacuum cleaner does sometimes.
7. If you see any dust or lint, pull those out. Lightly spray cleaner onto a rag and wipe this area clean.
8. Put the ball back, and twist the cover back on.

Note: DON'T spray cleaner directly onto the mouse. It could run down inside. Never spray cleaner directly into the bottom of the mouse.
LESSON 3 – YOUR FIRST EMAIL

E-mail is nowadays a very important tool in communication. Email users can send letters and messages to their loved ones and friends very fast even they live miles away.

To use email, the first step is to register any website that offers email services. Find one that is free. Let’s take Yahoo Mail ® as an example.

1. Open the Internet Explore. Type on the address bar http://mail.yahoo.com.
2. When login page displayed completely, click Sign Up.
3. Fill out the necessary information about yourself.
4. Fill in the text box with the Yahoo ID and password. Yahoo ID and password must be unique for security but make sure to remember them.

5. Choose a secret question and its answer. This is also important to be remembered in case you forgot your Yahoo ID and password.

- Note: Every time you login and forgot your ID and/or password, click on forgot password. Answer the necessary questions including the answer to the secret question.

2. Select an ID and password

Yahoo! ID and Email [_____@yahoo.com] Check
Password
Re-type Password

3. In case you forget your ID or password...

Alternate Email
Security Question - Select One -
Your Answer

6. To confirm, type the code in the text box provided shown on the web page. This is case sensitive so capital letters should be typed as capital.

7. Place a check on “I have read and agree to the Yahoo! Terms of Service and Yahoo! Privacy Policy, and to receive important communications from Yahoo! electronically.”

8. To complete the registration, click Create My Account.
Note: Since you are below 18 years old, Parent Verification will appear please ask your mom, dad, guardian or teacher to fill-out the form so that you can freely use Yahoo Mail.

After creating an account, log-on to the Yahoo Mail by typing the ID and password. You are now ready to type your first email. Here are the steps:

1. On the left side of the screen, click New.
2. On the text box for “To:”, write the email address of the person that you want to send the email. You can send it to more than one person by typing semi-colon after every email address.
3. On the text box for “Subject:”, write the topic or title of what your email is all about.
4. Write the message on the bigger text area. Be sure that you write with courtesy.
5. If you’re done typing your message, click Send.
6. To completely close the email, click Sign Out.
Alignment
Alignment is the position of lines in a paragraph to the left and right margins of the document; the positions of these can be left-aligned, centered, right-aligned, or justified

Arrow Keys
The arrow keys on the keyboard can be used to move your cursor around your document

BACKSPACE
The [BACKSPACE] key on the keyboard is most often used to delete data or characters

Bold
Bold characters on the printed page appear as darker characters or make them appear "thicker."

Borders
Borders are boxes that are placed around text, pages, and tables.

Browse
It lets you look around for something in MS Word. For instance, you could look for specific text or another document with another filename.

Centering
Centering is the placement of a line of text or picture in the center of the screen or page

Clip Art
Clip art consists of pre-designed images that can be placed within a document.

Close
Use the Close command on the File menu to complete your work on a document and put it away without leaving Word.
Copies
The Copies area allows you to indicate the number of copies to print by typing the number in the Number of copies text box.

Courier New
Courier New is a mono-spaced font that is available on every Windows-based computer.

Crop
Crop describes the editing of a graphic by trimming off unwanted portions of the image.

Current Document
The current, or active document is the document you see on the Word screen.

Default
Default means standard. Default settings are the settings that Word uses unless you ask it to use other settings.

Document
A document is any data file that is created by a specific application.

Document Field
A field is an area in your document where a specific type of data is entered or calculated.

Double-click
To double click, hold the mouse steady while you press the left mouse twice quickly.

Exit
Use the Exit command on the File menu to close all documents and leave Word entirely.

Field
A field is an area in your document where a specific type of data is entered
File List
The file list appears under the Look in text box in the Open dialog box, and shows the documents or folders in the current folder.

File Name
Word assumes that you want to use the first line of your document as its file name, and places this text in the File name text box in the Save As dialog box.

File Name Text Box
Use the File name text box in the Open dialog box to enter the name of the document you want to open.

Folder
A folder is an area on the disk that can contain files and subfolders that are usually related by type, purpose, or application.

Font
A font is a style and size of type, such as Times New Roman, 12 point, bold. A font is a set of all the characters available in one typeface and size, including uppercase and lowercase letters, punctuation, and numerals.

Font Formatting
Font Formatting changes the appearance of the text. Font formatting includes enhancements such as font style (bolding, centering, and underlining), point size (12 pt), and font typeface (Times New Roman, Arial, and Courier).

Format Picture Dialog Box
Use the Format Picture dialog box to define the size, position, color, or contrast of the selected picture, or to set how the text wraps around the picture in the document.

Formatting Toolbar
Located under the standard toolbar, the formatting toolbar gives quick access to various formatting commands and functions such as font type and style and text alignment.
Full Screen View
Full Screen view, available on the View menu, provides full-screen access to the document by hiding Word's non-document areas such as the menu bar and toolbars. When you select Full Screen view, Word opens the Full Screen toolbar that you can use to return to the last view you were using before selecting Full Screen view.

Graphics
Graphics are images such as clip art, word art, graphs, and charts.

I-beam Mouse Pointer
The mouse pointer turns into an I-beam mouse pointer when it is within the document area. Use the I-beam mouse pointer to place the insertion point in a document.

Indentation
An indentation is an amount of space measured from the page margin that is applied to a paragraph or an area of a document.

Indents and Spacing
The Indents and Spacing in the Paragraph dialog box allows you to apply various measurements and other options to selected paragraphs.

Italic
Italic characters appear on the screen slightly tilted to the right. Italics is usually used to provide special emphasis to text.

Justified Alignment
It is a type of alignment where all lines start at the left margin and end at the right margin. To accomplish this, Word adjusts the spacing between words, which can result in uneven and "loose" spacing.

Left Alignment
Left alignment is Word's default alignment for body text. The left side of the paragraph is aligned with the left margin or indent, and the right side is "ragged."
Line Spacing
Line spacing refers to the number of lines used by each line of text. In single-line spacing, each line of text is followed by another line of text, and there are no blank lines in between. In double-line spacing, each line of text is followed by a blank line.

List Box
A list box is a box that contains a list of available choices, such as files or field names.

Look In Text Box
The Look in text box in the Open dialog box lists the current folder and can be used to show other disks or folders on the system.

Margin
The margin is the amount of blank space, usually measured in inches, above and below and to the right and left of the main body of a document.

Margins Card
The Margins card in the Page Setup dialog box contains the margin settings for the document. They measure the distance in inches from the edges of the paper.

Menu Bar
The menu bar contains the names of Word's menus and is used to navigate through their commands.

Online Layout View
Online Layout View is better for viewing documents on-screen. It shows the document map which makes it easy to move around in the document.

Open Dialog Box
Use the Open dialog box to access an existing document so that you can open it in Word.

Outline View
Outline View provides a structured view of the document, arranging its contents according to heading levels and opening the Outlining toolbar for modifying the document's organization.
Page Layout View
Page Layout View shows the document's margins, headers and footers, frames, and other elements, thus providing a more accurate representation of what a document will look like when it is printed.

Page Setup Dialog Box
The Page Setup dialog box allows you to change the margin settings and layout of a document as well as to determine the paper size and the paper source for the printer.

Paragraph
A paragraph in Word begins where you start typing, and it ends where you press [ENTER].

Paragraph Formatting
Paragraph formatting includes formatting options such as text alignment, indents, tabs, margins, and justification.

Paragraph Style
Paragraph styles are represented by the paragraph mark on the Style list and are more common than Character styles. When you apply a Paragraph style, the characteristics of that style are applied to the entire paragraph.

Picture Toolbar
The Picture toolbar contains buttons that you can use to format the selected picture. The toolbar appears, usually under the Formatting toolbar, when you insert or select a picture in a document, and it closes when you deselect the picture.

Point
Pointing is the action of placing the mouse pointer over the desired object or text.

Preview Area
In the Font dialog box, the Preview area displays an example of the selected font. Many dialog boxes in Word contain similar Preview areas.
Print Preview
Print Preview in Word allows you to see how your document will look on the page before it is printed.

Print Range
The Print range area allows you to specify parts of the document to print. The All option prints the entire document. The Current page option prints the page where the insertion point is located. The Pages option allows you to specify which pages to print by typing their page numbers.

Right Alignment
With right alignment, the right side of the paragraph is aligned with the right margin or indent, and the left side is "ragged."

Rulers
The rulers are located below the formatting toolbar and on the left side of the screen. They are used to place and show tabs, margins, and indents.

Save A Document
If you want to use a document again, you should save it on a disk. When you save a document, you name it and tell Word where you want to store it.

Save As
Use the Save As command on the File menu to open the Save As dialog box if you want to save the current document under a new name or store it in a different folder or disk while also keeping the original version.

Save As Dialog Box
Use the Save As dialog box to save the current document for the first time, save the current document under a different name, or save the current document in a different folder or on a different disk.

Screen Element
A screen element is an object on the screen, such as a button or a ruler. Screen elements will vary between the different Word views.
Scroll Bar
The scroll bar is a panel for moving the display horizontally or vertically within a window.

Scroll Bar Arrows
The scroll bar arrows, located at the ends of the scroll bars, may be clicked to slowly move the view within a window up, down, or across.

Scroll Box
The scroll box is the box within a window's horizontal or vertical scroll bar that indicates your position within the window. Use it to navigate windows horizontally and vertically in very large increments by clicking-and-dragging them along the scroll bar.

Scrolling
Scrolling is the act of moving up and down (vertical scrolling) or across a window (horizontal scrolling) using the scroll bars, the scroll arrows, or the scroll boxes.

Select
In order to work with an object, you must first select or activate it. One way to select an object is by clicking it with the mouse.

Selecting
Selecting is highlighting an object or data in order to perform a command or operation.

Shading
Shading is a Word option that lets you apply varying degrees of grayness as well as patterns to the backgrounds of selected text.

Shading Color
Shading color is the percentage or type of shading applied to a selected paragraph, table cell, or frame.

Shift
The [SHIFT] key on the keyboard is used in conjunction with other keys and mouse actions to capitalize letters and perform various commands and functions.
Size
Size refers to the width and height of a font or graphic.

Sizing Handles
Sizing handles are the eight small, black squares that appear at each corner and along the sides of a selected graphic. Dragging a sizing handle resizes the graphic.

Spacing
Spacing refers to the space above and below a paragraph. Spacing is measured in points.

Spelling And Grammar Dialog Box
Use the Spelling and Grammar dialog box to fix spelling or grammar errors or to add words to the spelling dictionary.

Spelling And Grammar Options
Set the grammar and spelling rules on the Spelling and Grammar card in the Options dialog box.

Standard Toolbar
Located under the menu bar, the standard toolbar gives quick access to various often used commands and functions such as opening, saving, and printing files.

Start Button
Use the Start button on the Taskbar to show the Start menu to open applications.

Status Bar
Located at the bottom of the window, the status bar contains information about many formatting options such as current font, insert and overtype mode, and page number.

Status Box
The status box is an informational panel on one end of the Taskbar that provides information about the system.
Style Gallery
The Style Gallery, opened from the Format menu, allows you to preview the styles associated with the current template as well as other templates.

Symbol Font
Symbol fonts contain special characters that are not part of the alphabet. A common example of a symbol font is Wingdings.

Tab
Tab is the key you press to move the insertion point the next indicated tab stop. Word automatically sets tabs every half inch.

Tabs
Tabs are the titles of the cards found in some dialog boxes. Clicking on one brings that card to the front.

Taskbar
The Taskbar is a panel on the Desktop that contains the Start button.

Times New Roman
Times New Roman is a serif font that is available on every Windows-based computer. Word's default font is Times New Roman.

Title Bar
The title bar shows you the name of the current document and contains the standard Windows control buttons.

Toolbar
A toolbar is a group of tools of usually related functions. Toolbars can contain buttons, menus, or combinations of both that can be used to quickly perform actions in Word.

ToolTip
A ToolTip is a descriptive text box that appears when the mouse pointer is held over a tool, button or other object.

TrueType Font
TrueType fonts are fonts that are installed with Windows. They can be scaled to any size and look on the screen much as they will in the printed document.
Tool
A tool is a shortcut button, usually shown on a bar near the top of a window that provides quick access to a commonly used command.

Underline
Underlining places a thin line beneath selected text.

View
There are four views available in Word: Normal, Page Layout, Online Layout, and Outline. Some show you how the document will look when it is printed, and some make working in Word quick and easy.

View Buttons
The View buttons allow you to switch between the most common Word views.

What's This?
It is a command on the Help menu to activate the Help mouse pointer.

Window Menu
The Window menu provides a list of all the available windows and allows you to switch to any of them or arrange all of them so that they can be seen at one time.

Working Screen
When you start Word, the application opens to the working screen. The screen contains the application window, the document window, and tools for using Word successfully.

Writing Style
Use the various writing styles to define the grammar rules for checking grammar. Choose from casual, standard, formal, or technical styles, or create your own custom style. You also can change the rules that each style uses to check the grammar.
REFERENCES:


UNIT 1

Introduction

This course is best for students 9 years old and above. The age requirement corresponds to psychomotor dexterity to handle touch typing. Throughout the year, students will be spending almost half the time practicing touch typing and the other half learning a word processor. This unit will expose introduce Microsoft Office Word as a word processor tool. Students will be able to use basic cursor commands, edit existing documents, save and print. Students will be using templates and ready made documents with text pertaining to their other academic subjects. Schools and teachers may modify or replace these with their own materials and still meet the learning requirements.

What will the students know?

They can identify parts of the main interface and find the necessary icons and menu to do basic editing.

What can the students do?

They can confidently carry out tasks and instructions to edit and manipulate existing documents and save it.

What habits will be formed?

They will be very mindful of how they use the computer, watching for proper posture and ergonomics.

Reminders:

1. The Checklist of Proper computer usage is essential. Constant reminders on the proper use of computers with this tool forms good habits that are carried on for the rest of their life.
## COMPUTER LABORATORY POLICY

<table>
<thead>
<tr>
<th>Things that should be observed from students:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Forming a line before and after entering computer laboratory</td>
</tr>
<tr>
<td>2. Sit on designated computer unit and place bags on designated place</td>
</tr>
<tr>
<td>3. Arrange and clean computer peripherals.</td>
</tr>
<tr>
<td>4. Bring out notebooks and books.</td>
</tr>
<tr>
<td>5. Use the keyboard and mouse gently</td>
</tr>
<tr>
<td>6. Perform laboratory activities promptly</td>
</tr>
<tr>
<td>7. Participate and listen to class discussions attentively</td>
</tr>
<tr>
<td>8. Save and close all files</td>
</tr>
<tr>
<td>9. Arrange seats and computer peripherals before leaving the laboratory</td>
</tr>
</tbody>
</table>

Checked By: ____________________________

Signature
Technology and my Community

Instruction: Fill-out the table

<table>
<thead>
<tr>
<th>Community helper</th>
<th>Technology used</th>
<th>Computer program used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Create an art work that shows how technology helps my community
LESSON # 3

Exercise # 2

Keyboarding

Instruction: Write the corresponding letter for the drawn hand (fingers)
Instruction: Identify parts of the word processor screen. Draw a few basic icons.
*(Font, saving, printing).*
LESSON # 4   Exercise # 4

Saving

Instruction: List down the steps for:

1. Saving a file with a backup.

2. Saving a file as a webpage

3. Saving a file with extra properties

4. Searching for a file with a specific property

5. Recovering a file version/backup
Integrated Topic: Type a poem

Some One
by Walter de la Mare

Some one came knocking
At my wee, small door;
Some one came knocking,
I'm sure - sure - sure;
I listened, I opened,
I looked to left and right,
But naught there was a-stirring
In the still dark night;
Only the busy beetle
Tap-tapping in the wall,
Only from the forest
The screech-owl’s call,
Only the cricket whistling
While the dewdrops fall,
So I know not who came knocking,
At all, at all, at all.
Integrated Topic: Type a poem

Here’s a Haiku to help you remember:

I am first with five
Then seven in the middle --
Five again to end.

Beaches
By Keitlyn Guenther

Sand scatters the beach
Waves crash on the seashore
Deep blue water shimmers
UNIT 2

Introduction

This unit will introduce using templates, images and cliparts. Students will still be engaged in editing academic documents but will also begin using templates for letters, posters and greeting cards. Students can do great things with little effort using templates. They will also be able to learn techniques of doing things with templates. It is advised to go beyond “just completing” activities and tasks and move towards studying “how they did that” with the help of the templates.

What will the students know?

They can name almost all the icons in the standard and formatting toolbar and state what it is used for.

What can the students do?

They can make presentable documents such as letters, cards and posters with the help of templates. Their typing skills will be moving towards the QWERTY row.

What habits will be formed?

They will be conscious about positioning their fingers properly every time they begin typing.

Reminders:

Patience is exhorted from the teacher in order to balance development of touch typing skills and learning the word processor.
# COMPUTER LABORATORY POLICY

<table>
<thead>
<tr>
<th>Things that should be observed from students:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1   Forming a line before and after entering computer laboratory</td>
<td></td>
</tr>
<tr>
<td>2   Sit on designated computer unit and place bags on designated place</td>
<td></td>
</tr>
<tr>
<td>3   Arrange and clean computer peripherals.</td>
<td></td>
</tr>
<tr>
<td>4   Bring out notebooks and books.</td>
<td></td>
</tr>
<tr>
<td>5   Use the keyboard and mouse gently</td>
<td></td>
</tr>
<tr>
<td>6   Perform laboratory activities promptly</td>
<td></td>
</tr>
<tr>
<td>7   Participate and listen to class discussions attentively</td>
<td></td>
</tr>
<tr>
<td>8   Save and close all files</td>
<td></td>
</tr>
<tr>
<td>9   Arrange seats and computer peripherals before leaving the laboratory</td>
<td></td>
</tr>
</tbody>
</table>

Checked By: ____________________________

Signature
Typing practices and game

**GCOMPRIS**

**Instruction:**

1. Open the GCOMPRIS application.
2. Select the 'DISCOVER THE COMPUTER' from the left side menu.
3. Click on the 'KEYBOARD MANIPULATION' exercise.
4. Play the SIMPLE LETTERS exercise to practice your keyboarding skills.
5. Record your progress from level 1 to level 6.
Lesson #1  Exercise #2

Typing practices and game
TUX TYPING

Instruction:

1. Open the TUX TYPING application.
2. From the Options, select LESSONS to do series of typing exercises.
3. Record your progress from lesson 1 to 8.
LESSON # 1  Exercise # 3

Typing practices and game
TUX TYPING

Integrated topics:

- Alphabets, Animals, Astronomy, Colors, Fruits, Oceans and Continents, Numbers

Instruction:

1. Open the TUX TYPING application.
2. From the Options, select FISH CASCADE to do series of typing exercises of 3 levels (Easy, Medium, Difficult)
3. Record your progress in each level.
LESSON # 1  Exercise # 4

Typing practices and game
TUX TYPING

Integrated topics:

- Alphabets, Animals, Astronomy, Colors, Fruits, Oceans and Continents, Numbers

Instruction:

1. Open the TUX TYPING application.
2. From the Options, select COMIT ZAP to do series of typing exercises of 3 levels (Easy, Medium, Difficult)
3. Record your progress in each level.
NAME: ____________________________     DATE: __________
GRADE AND SECTION: __________________Score: __________

LESSON # 2                   Exercise # 5

Using the Menu

Instructions:
There are 3 different files available to be opened.
Edit the files as follows:
1. Open the file Exer5Doc1.
2. Copy the first paragraph and paste it at the bottom of the page.
3. Save As the file with as Exer5NewDoc then close.
5. Find the name: “Dorra” and replace it with “Fern”
7. Open the Exer5Doc3.
8. Copy the everything in Exer5Doc3 and paste it on the next page of the Exer5Doc2.
10. Print the file.
12. Close the application.

Refer to the given Chart to check which menu commands are present.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Copy</td>
<td>Normal</td>
</tr>
<tr>
<td>Save</td>
<td>Cut</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Save As</td>
<td>Paste</td>
<td>Outline</td>
</tr>
<tr>
<td>Print</td>
<td>Find</td>
<td>Web Layout</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Replace</td>
<td>Zoom</td>
</tr>
</tbody>
</table>

Reference: pbskids.org
Every organism needs to obtain energy in order to live.

For example, plants get energy from the sun, some animals eat plants, and some animals eat other animals.

A food chain is the sequence of who eats whom in a biological community (an ecosystem) to obtain nutrition.

A food chain starts with the primary energy source, usually the sun or boiling-hot deep sea vents. The next link in the chain is an organism that make its own food from the primary energy source -- an example is photosynthetic plants that make their own food from sunlight (using a process called photosynthesis) and chemosynthetic bacteria that make their food energy from chemicals in hydrothermal vents. These are called autotrophs or primary producers.
NAME: ___________________________ DATE: __________
GRADE AND SECTION: ______________ Score: __________

LESSON # 3  Exercise # 7

Formatting

Instruction: Refer to Exercise #6.

Draw the icons that are used on the following formatting commands on the space provided.

Font Style
1. Bold
2. Italic
3. Underline

Alignment
4. Justify
5. Center
6. Left align
7. Right align

Font
8. Font Face
9. Font Size

Paragraph
10. Line Spacing
**Lesson # 4  Exercise # 8**

**Formatting**

**Instruction:** Identify the shortcut keys of the following commands. Draw the icons (if applicable)

<table>
<thead>
<tr>
<th>COMMANDS</th>
<th>SHORTCUT KEYS</th>
<th>ICONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Justify</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double Underline.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Center</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find and Replace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Superscript</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Align Left</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Align Right</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subscript</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redo last action</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply Default paragraph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.5 Line Spacing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go to beginning of line.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go and select to the</td>
<td></td>
<td></td>
</tr>
<tr>
<td>beginning of a line.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go and select to end of</td>
<td></td>
<td></td>
</tr>
<tr>
<td>line.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Instruction: Create a letter document using a Template

To use a template in creating a document do the following:

1. From the File menu, click New.

2. In the New Document task pane, under the Templates section, click On My Computer.

3. Double-click the folder that contains the template that you want to use. A list of all the templates contained in that folder appears in the center box.

4. Click the template that you want to use. You can preview the selected template or view the template’s properties:
   - To preview the template, click the Preview icon. A preview of the template appears in the box on the right.
   - To view the template’s properties, click the Document Properties icon. The template’s properties appear in the box on the right.

5. Click Open. The Templates window closes and a new document based on the selected template opens in Word. You can edit and save the new document just as you do in any other document.
Working with Templates

Creating a Letter using Template

**Instruction:** Use a letter template in creating the letter document below. Save your work as Acceptance Letter_<full name>.

Mr./Mrs./Ms. _______________ (Name of your teacher)
(School Name)
(School Address)

Dear Sir/Ma’am __________: (Last Name)

Please accept this letter as written notification that I am not able to attend the school play on Friday due to family illness.

Hope for your kind consideration.

Sincerely,

Your Signature

Your Typed Name

Genetic - Making IT work for you
Working with Templates

Creating a Letter using Template

**Instruction:** Use a letter template in creating the letter document below. Save your work as Appreciation Letter_<full name>.

Dear Friend,

I just wanted to let you know again how much I appreciate your support while I was in the hospital. It meant so much to me that you would take the time to come see me. Your kind words, company, and prayers really made a difference.

Thank you again for your thoughtfulness and your friendship.

Warm Regards,

_____________________

Your Name
Using Templates
(Brochure, Posters, Agenda, Fax)

Instructions:

1. Open the Microsoft Word Brochure Template under the Publications tab.

2. Enter your text into each of the panels in the template.

3. Click on the panel where you want to place a photo or graphic and click Insert, then Picture... From File ...then navigate to the folder where you have photos and graphics stored. Double-click on the file (graphics/picture) you would like to place in the brochure.

4. Run your spelling and grammar check and save the file.

5. Print a copy of your brochure as a test. Click File, then Print. Click on the radio button next to "Pages" and enter "1" in both boxes. Click "OK" to print the first page of your brochure.

6. After the first page of your brochure has printed, reload the printed page upside down into your printer to print the second page. Click File, then Print. Click on the "Pages" radio button and enter 2 in the boxes. Click OK. Proof your brochure and make any needed changes before printing multiple copies.
LESSON # 6  Exercise # 13

Make a Brochure using Templates

Instruction: Create a brochure to advertise your club/organization (example: IT Club/Robotics Club). Choose the tri-fold template. Include some appropriate graphics/pictures. Provide necessary information (Activities, Projects, Accomplishments, etc)

Sample Brochure
LESSON # 6  Exercise # 14

Make a Poster using Templates

Instruction: Create a poster to advertise your school or any school program/activities. Include some appropriate graphics/pictures. Provide necessary information.

Sample Poster

Sample Picture courtesy of SchoolPoster.hda.co
Creating an Agenda in Microsoft Word

Instructions:

1. Open the Agenda Wizard. Click on "File" and then select "New." In the task pane that opens to the right click on "On My Computer." In the new window that opens click on the "Other Documents" tab. Finally, click twice on the icon that is labeled "Agenda Wizard." Click on "Start" once the Agenda Wizard opens to begin.

2. Choose your style. In the first window you can choose your style by clicking on the desired style from the displayed list. Click "Next" to continue.

3. Choose your details. In the next window that opens enter the desired details you wish to include into their corresponding fields. Enter the details and then click "Next" to continue.

4. Select the headings that you want to include. In this window you can check or uncheck heading boxes to add or remove desired headings. Make your selection and then click "Next" to continue.

5. Enter the names. In this window you can enter or remove names that you wish to be included in the agenda by entering the desired text into the labeled fields. When you're finished click on "Next" to continue.

6. Create agenda topics. In the next window that opens you can create new agenda topics by entering in the topic name, person and minutes into the corresponding fields. Click the "Add" button to add completed agenda topics. When you're finished adding topics click on "Next" to continue.
7. Add or remove minutes. In the final window that opens you can specify whether you wish to add or remove minutes from the agenda by clicking on the “Yes” or the “No” radial button. Then click “Next” to continue.

8. Implement the agenda. Click on the “Finish” button to create your new agenda.
Make an Agenda using Templates

Instruction: Create a meeting agenda for your club regular meeting. Use the meeting Agenda template. Provide necessary information.

Sample Meeting Agenda Outline

- Meeting Title
- Date of Meeting
- Time of Meeting
- Place of Meeting
- Meeting Called by:
- Attendees:
- Materials Needed:
- Additional Instruction/Information:
Creating Table of Contents

Instructions:

1. Place your cursor at the point in your document when you want to insert the table of contents.
2. From the main menu, choose Insert > Reference > Index and Tables...
3. The Index and Tables window opens.
4. Click Table of Contents if it isn’t already displayed.

Some of the important features of the Index and Tables tab are as follows:

- Use the Index tab to set the table’s attributes.
- Print Preview: This area shows you a little about how your table of contents will be formatted.
- Right align page numbers: When selected, your page numbers will be aligned at the right-hand border of your document. Deselect this checkbox to show the numbers right next to the heading.
- Tab leader: In the example shown in the picture above, a series of dots leads up to the page number. You can change this dashes or underscores, or remove the leading character altogether.
- Formats: The Print Preview box shows you the formatting for your table of contents. However, Word also provides a number of other standard styles. You can completely customize the formatting of your table of contents by using the Modify button.
Creating Table of Contents

Instructions:

Create a table of contents on the sample document below. Refer to the sample TOC.

*Note: Use standard Headings to apply automatic Table of Contents*

Sample TOC

<table>
<thead>
<tr>
<th>Table of Contents</th>
<th>Lesson 1: Gallery</th>
<th>Lesson 2: Drawing in Writer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery</td>
<td>Copy an image from the Gallery and work with that image.</td>
<td>Make your own drawing in a text file.</td>
</tr>
<tr>
<td>Drawing in Writer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pictures in Text File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail Merge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print in an Envelope</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 3: Pictures in Text Files</th>
<th>Lesson 4: Mail Merge</th>
<th>Lesson 5: Print in an envelope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a picture that you see on your screen into your Open Office text file and then modify the picture</td>
<td>Introduction to Mail Merge which includes a Form Letter, Labels, Envelopes and an Address Book</td>
<td>Discuss how to print a #10 envelope or any size of envelope.</td>
</tr>
</tbody>
</table>

Page 1

Page 2

Page 3

Page 4

Page 5
UNIT 3

Introduction

The unit will cover details for formatting and the design principle behind using fonts and colors. Students will engage themselves in using word processors for non-standard documents like songs, poems, calendars, and the like. They will use the formatting tools to create documents that go beyond simple reports. Formatting will include characters, paragraphs and tables.

What will the students know?

They can understand the principles behind design and lay-outing using fonts, colors and white space. They will be able to find the corresponding menu commands or icons to finish their task.

What can the students do?

They can apply lay-outing and formatting techniques to documents to achieve the design they want.

What habits will be formed?

They will plan out thoughtfully their document design before using a word processor.

Reminders:

Teachers are encourage to supplement the activities with word-processor requirements coming from other academic subjects.
# COMPUTER LABORATORY POLICY

<table>
<thead>
<tr>
<th>Things that should be observed from students:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Forming a line before and after entering computer laboratory</td>
<td></td>
</tr>
<tr>
<td>2. Sit on designated computer unit and place bags on designated place</td>
<td></td>
</tr>
<tr>
<td>3. Arrange and clean computer peripherals.</td>
<td></td>
</tr>
<tr>
<td>4. Bring out notebooks and books.</td>
<td></td>
</tr>
<tr>
<td>5. Use the keyboard and mouse gently</td>
<td></td>
</tr>
<tr>
<td>6. Perform laboratory activities promptly</td>
<td></td>
</tr>
<tr>
<td>7. Participate and listen to class discussions attentively</td>
<td></td>
</tr>
<tr>
<td>8. Save and close all files</td>
<td></td>
</tr>
<tr>
<td>9. Arrange seats and computer peripherals before leaving the laboratory</td>
<td></td>
</tr>
</tbody>
</table>

Checked By: ____________________________

Signature
LESSON # 2   Exercise # 1

Formatting Characters

Instruction:
1. Open the file Energy.doc and read the context.
2. Find all misspelled words and strike through the words. Type the correct word next to it.
3. Underline all the word energy in the paragraph.
4. Italicize all the word light and heat.
Ancient Egyptians really did write fractions this way!

Instead of writing $\frac{2}{5}$, they wrote $\frac{1}{3} + \frac{1}{15}$. For $\frac{2}{7}$, they wrote $\frac{1}{4} + \frac{1}{28}$. Some of the fractions were very complicated. For $\frac{2}{29}$, they wrote $\frac{1}{24} + \frac{1}{58} + \frac{1}{174} + \frac{1}{232}$. How do we know about Egyptian fractions?

The written record goes all the way back to 1650 B.C.: the Rhind Mathematical Papyrus contains a table of Egyptian fractions copied from another papyrus 200 years older. Ancient Egyptians needed to understand a lot of complex mathematics to create a table like this. We know they used this system for over 2,000 years... but we don’t know why!
GENETIC

NAME: __________________________ DATE: __________
GRADE AND SECTION: ______________ Score: __________
LESSON # 2 Exercise # 3

Formatting Characters

Instruction:
1. Open and read the file King David.doc
2. Edit and apply the correct font technique.
3. Save your work as King David_<Fullname>.
Genetic – Making IT work for you

LESSON # 3  Exercise # 4

Cursor Controller Keys

Instruction:
1. Open your previous activity Energy.odt.
2. Using the cursor keys follow the instructions to be presented in a slide.
3. Then answer the questions below after each instruction.
4. Write your answer on the space provided after each question.

Questions

1. What is the last word in the document? ____________________.
2. What is the second word in the document? ____________________.
3. How many times the word energy used in the document? ____________.
4. In what paragraph you can find the phrase: You need to eat some food to refuel? ____________.
5. How many paragraphs does the document have? ____________.
Genetic – Making IT work for you

LESSON # 5   Exercise # 5

Working with Numbers

Instruction:
1. Open a new text document.
2. Make a multiplication table by inserting table in the document.
3. Save your work as Multiplication table_<Fullname>.

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>4</td>
<td>6</td>
<td>8</td>
<td>10</td>
<td>12</td>
<td>14</td>
<td>16</td>
<td>18</td>
<td>20</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>6</td>
<td>9</td>
<td>12</td>
<td>15</td>
<td>18</td>
<td>21</td>
<td>24</td>
<td>27</td>
<td>30</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>8</td>
<td>12</td>
<td>16</td>
<td>20</td>
<td>24</td>
<td>28</td>
<td>32</td>
<td>36</td>
<td>40</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>10</td>
<td>15</td>
<td>20</td>
<td>25</td>
<td>30</td>
<td>35</td>
<td>40</td>
<td>45</td>
<td>50</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>12</td>
<td>18</td>
<td>24</td>
<td>30</td>
<td>36</td>
<td>42</td>
<td>48</td>
<td>54</td>
<td>60</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>14</td>
<td>21</td>
<td>28</td>
<td>35</td>
<td>42</td>
<td>49</td>
<td>56</td>
<td>63</td>
<td>70</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>16</td>
<td>24</td>
<td>32</td>
<td>40</td>
<td>48</td>
<td>56</td>
<td>64</td>
<td>72</td>
<td>80</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>18</td>
<td>27</td>
<td>36</td>
<td>45</td>
<td>54</td>
<td>63</td>
<td>72</td>
<td>81</td>
<td>90</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
<td>60</td>
<td>70</td>
<td>80</td>
<td>90</td>
<td>100</td>
</tr>
</tbody>
</table>
All Things Bright and Beautiful

~Cecil Frances Alexander

All things bright and beautiful,
All creatures great and small,
All things wise and wonderful,
The Lord God made them all.

Each little flower that opens,
Each little bird that sings,
He made their glowing colors,
He made their tiny wings.

The purple-headed mountain,
The river running by,
The sunset, and the morning,
That brightens up the sky;

The cold wind in the winter,
The pleasant summer sun,
The ripe fruits in the garden,
He made them every one.

He gave us eyes to see them,
And lips that we might tell,
How great is God Almighty,
Who has made all things well.
My Favorite Song

Instruction:

1. Open a new text document and type your favorite song.
2. Save your work as My Favorite Song_<Fullname>.
My Daily Planner

Instruction:

1. Open a new text document and create your own daily planner (see example below).
2. Save your work as My daily planner_<Fullname>.

Date ___________________  

<table>
<thead>
<tr>
<th>Time</th>
<th>To do list</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
 LESSON # 6   Exercise # 9

My Calendar

Instruction:

1. Open a new text document and make your birth month 2010 calendar (see example below).
2. Save your work as Calendar_<Fullname>.

<table>
<thead>
<tr>
<th>SUN</th>
<th>MON</th>
<th>TUE</th>
<th>WED</th>
<th>THUR</th>
<th>FRI</th>
<th>SAT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>20</td>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
<td></td>
</tr>
</tbody>
</table>

Genetic – Making IT work for you
UNIT 4

Introduction

The unit centers on using a word processor to enhance visual learning. It covers using drawing tools and more advanced features of handling images and pictures. Students will use images which they in turn can label the parts, or come up with a storyboard sequence. Activities will ask students to make concept maps and other graphic organizers.

Students are also expected to be using the computer laboratory time to make academic requirements for other subjects using a word processor.

What will the students know?

They can identify and compare menu commands against icons and short cut keys. They can state the ways of using the drawing tools and all its properties.

What can the students do?

They can layout a document with pictures and diagrams.

What habits will be formed?

They will be critical of layout design and be open to other ways of presenting a topic visually.

Reminders:

It is highly recommended that visual organizers are first done on paper and shown to the teacher or parent before actually making them in a word processor. This method will distinguish the knowledge in using visual organizers against using the word processor.
# COMPUTER LABORATORY POLICY

<table>
<thead>
<tr>
<th>Things that should be observed from students:</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1   Forming a line before and after entering computer laboratory</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2   Sit on designated computer unit and place bags on designated place</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3   Arrange and clean computer peripherals.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4   Bring out notebooks and books.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5   Use the keyboard and mouse gently</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6   Perform laboratory activities promptly</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7   Participate and listen to class discussions attentively</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8   Save and close all files</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9   Arrange seats and computer peripherals before leaving the laboratory</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Checked By: ____________________________

Signature
LESSON # 2   Exercise # 1

**Cinderella**

Instructions:
1. Follow the Instruction
2. Open Microsoft Office Word.
3. Look for a file named Cinderalla.doc
4. Choose and open.
5. Change the layout to landscape.
6. Set the left and right margin to 1.
7. Set the top and Bottom margin to 1.
8. Insert page number.
9. Add page Border.
10. Set all four borders and use 5.05 pt.
11. Save your Work as Cinderella_<Fullname>.
12. Print your work with Primo PDF and save.
David and Goliath

Instructions:
1. Follow the Instruction
2. Open Microsoft Office Word.
3. Look for a file named david and goliath.doc
4. Choose and open.
5. Change the layout to landscape.
6. Set the left and right margin to 1.
7. Set the top and Bottom margin to 1.
8. Insert page number.
9. Add page Border.
10. Set all four borders and use 5.05 pt.
11. Save your Work as David_<Fullname>.
12. Print your work with Primo PDF and save.
Memory of my Town

Instructions:
1. Follow the Instruction
2. Open Microsoft Office Word.
3. Look for a file named memory of my town.doc
4. Choose and open.
5. Change the layout to landscape.
6. Set the left and right margin to 1.
7. Set the top and Bottom margin to 1.
8. Insert page number.
9. Add page Border.
10. Set all four borders and use 5.05 pt.
11. Save your Work as Memory of my town_<Fullname>.
12. Print your work with Primo PDF and save.
Handling Pictures

Instructions:

1. Open maria cristina.doc

2. In this template it is used as a Brochure.

3. Insert Pictures on a place holders

4. Rezise to fit the proportion.

5. Save your work as Maria Cristina_<fullname>
LESSON # 3     Exercise # 5

Doing it Themselves

Instructions:

1. Open the Microsoft Office Word.


3. Make a 3 column page.

4. Insert pictures from folder file Maria Cristina Brochure

5. Set the paper size to A4 and a landscape orientation.

6. Save as your work as Brochure_<fullname>
Adding Watermark

Instructions:
1. Open your previous work named Cinderella_<fullname>
2. Place a watermark beneath the document.
3. Type your name as your Watermark.
4. In your document insert a picture/ logo of your school
5. Save as your work as Watermark_<fullname>
NAME: ___________________________________________ DATE: ______________
GRADE AND SECTION: _____________________________ Score: __________
LESSON # 4  ________________________________ Exercise # 7

**Scrapbook**

**Instructions:**

1. Open the Microsoft Office Word.
2. Using your own photos, family photos and other old photos in your family
3. Do some creative design each page.
4. Label the pictures with names of the persons.
5. Add some Wacky callouts.
6. Save as your work as Scrapbook_<fullname>
Genetic – Making IT work for you

LESSON # 4   Exercise # 8

Body Parts

Instructions:
1. Label parts of the Body using drawing tool and textbox.
2. Save as your work as Body Parts_<fullname>

Parts of the Body

1. Nose               6. Neck
2. Hair               7. Arm
3. Eyes               8. Foot
4. Mouth             9. Ear
5. Hand              10. Leg

Parts of the Body
Call-out Signs

Instructions:

1. Open Microsoft Office Word.
2. Insert picture name comic_strip.jpg
3. Resize the image to make fit into the page
4. Complete their conversation. Use your own script. (see the image below)
5. Save as your work as Call-out_<fullname>
Jose P. Rizal

Instructions:

1. Open Jose Rizal.doc
2. Label and enumerate his occupation.
3. Type the occupation inside the circle.
4. Save your work as Rizal_<fullname>
My Mother/Father

Instructions:
1. Get an image of your Mother or Father.
2. Create your own concept map.
3. Give at least 5 characteristics of your Mother or Father.
4. Save your work as Mother/Father_<full name>.
Lessons # 6  Exercise # 12

Daily Routines

Instructions:
1. Open daily routines.doc
2. Label the pictures according to what they are doing.
3. Save your work as Daily Routines_<full name>.
LESSON # 7
Exercise # 13

Decorating, Coloring, Jazzing up my Drawings

Instructions:
1. Open your previous activity Scrapbook_<Fullname>.
2. Insert your latest picture (it can be your birthday, Christmas vacation etc.)
3. Add design to your picture/s by adding decorations and manipulating its color.